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Legal Disclaimer 

The product described in this documentation may be connected to, and/or communicate 

information and data via, a network interface, which should be connected to a secure network. It is 

your sole responsibility to ensure a secure connection to the network and to establish and maintain 

appropriate measures (such as but not limited to the installation of firewalls, application of 

authentication measures, encryption of data, installation of antivirus programs, etc.) to protect the 

product, the network, your systems, and the interface against any kind of security breach, 

unauthorised access, interference, intrusion, leakage, damage, or corruption or theft of data. We are 

not liable for damages or losses related to any such security breach, unauthorised access, 

interference, intrusion, leakage, damage, or corruption or theft of data. 
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What’s New 

Discover the latest enhancements and additions introduced in MineScape 

Update 2. 

CAD  

This update brought significant improvements to the MineScape CAD, as follows: 

Set/Trim/Extend to Boundary Enhancements 

• Trimming or extending line segments to boundary has been made easier 

by allowing users to choose whether to do it interactively or all at once. 

When users click the Set to Boundary, Trim to Boundary or Extend to 

Boundary Option in the Element Utilities Group of the Design Tab, a 

confirmation dialog box appears, as shown below. 

 
Confirmation Dialog Box 

• A new setting button has also been added to decide which Z values to 

apply on the resulting element 
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Select Z Value 

o Use original Z Values: maintain the Z values of the element being 

modified 

o Use the Boundary Line Z Values: use the Z values of the boundary 

line used to trim or extend the element 

RapidCAD 

• Added five Edit Options, which are Copy, Move, Offset, Drape, and Project, 

as part of the RapidCAD right-click options. 
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Additional RapidCAD Options 

• All features of RapidCAD, including Quick Edit Toolbar, Quick Element 

Options, and Quick Input Box, are now enabled by default. Previously, only 

the Quick Dropdown Menu was accessible without manual activation, 

while other features required enabling. Users can adjust these settings 

within the RapidCAD Node of the Graphics Settings Form, accessible by 

clicking the Dialog Launcher ( ) icon in the Graphics Group on the Home 

Tab of the CAD Ribbon. 

 
RapidCAD Node 

•  The Intersect and Trim Option, accessible in RapidCAD or Segment 

Group of the Design Tab, allows users to choose which Z values for newly 

trimmed vertices. By pressing the Space Bar, users can toggle between 

using the Z values of the first and second elements. 

Drape Element 

The Drape Elements Form has been enhanced with a new Add Vertices on 

Large Grade Changes Option. When the checkbox is ticked, new vertices will be 

added on any parts of the element that has a grade value that is outside of the 

grade change value. This helps to improve the accuracy of the resulting element.  
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Drape Element Form 

Polygon Centre  

The Polygon Centre Option has been added to automatically detect the centre 

point of polygons. Users can also snap the centre points as part of a new line 

segment.  The Option is available within the Graphics Toolbar. 

 
New Polygon Centre Option 

The magnified red boxes in the image below show the blue centre point within 

each polygon. The X, Y, and Z coordinates can be viewed by hovering over the 

centre point or via the Weighted Centre section in the Statistics Dock. 
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Polygon Centres 

Viewport Background Colour  

The Cycle Background Colours update enhances users’ ability to choose 

background colours for Viewports, offering a wider selection of preferences. The 

new settings layout utilises a table format to maximise the availability of 

background colour options. By default, MineScape includes 11 predefined colours, 

featuring both solid colour and top-to-bottom linear gradient options. 
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CAD Graphics Colours Settings 

Other CAD Enhancements 

• When a light bulb icon in the Display Dock is clicked, the respective 

elements on the CAD Window will automatically be hidden without being 

highlighted first. This will save time when huge data are currently opened.  

• The Height Cue dialog box has been enhanced with Preview and OK 

Buttons. The Preview Button enables users to preview selected colours 

after clicking Apply, without closing the dialog box. The OK Button closes 

the dialog box and applies the colour selection, streamlining the process 

when working with large datasets and multiple selected elements.  

• Multiple design files can be exported into AutoCAD DXF/DWG file formats 

through the Export Design Data Form. The Output and Control settings 

can be configured directly in this form and will always override the settings 

made in the Data Exchange Settings Form.  

  
Export Design Data to DWG Form 

Mesh 

Explore the latest enhancements and additions to mesh functionality. 
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Create Surface Meshes  

Two new sub-options have been added to the Create Surface Option within the 

Surface Mesh Group: Create Mesh from Layer and Create Mesh by Polygons, 

replacing the previous functionality of Create Surface Mesh from Design Data. 

 
Create Surface Sub-Options 

Both sub-options allow users to generate surface meshes with or without limit 

areas, supporting both standard and extended design file formats. Run by a 

module, they offer a selection of output mesh formats, with convenient export 

options to DXF. When creating meshes using extended design file formats, the 

mesh name file can use the polygon name. 

Create Mesh from Layer 

This feature simplifies surface mesh generation by eliminating the need for 

manual file loading onto the CAD Window. It is tailored for scenarios in which 

users aim to generate a mesh while honouring all elements within the nominated 

layer. Polygons can also be used to define limit areas, provided these polygons are 

located within the same layer. The feature outputs both single and multi-mesh 

files. 

Create Mesh by Polygons 

This feature streamlines surface mesh generation from multiple design files 

simultaneously while sourcing boundary polygons from different layers. By 

specifying polygon IDs as limit areas, users can define exclusion zones within or 

outside polygon boundaries. Multiple outputs are supported, including Separate 

Mesh Files, Combined Mesh, and Multi-Mesh. 

Re-added the Filter Functionality 

Brought back the Filter Option under the Point Cloud Group of the Mesh Tab.  
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Filter Option 

The Filter Points Form allows users to remove data points and reduce the 

number of point clouds within a dataset. Users can select the Thin Method, 

Output Resolution, and Output .LAS file name. 

 
Filter Points Form 

Plot Designer 

Rapid Plot  

The new Rapid Plot Option offers users a quick way to generate output plot files. 

By drawing or selecting a polygon, users can define the plotting area. Users can 

also customise the pre-defined paper parameters and input scale values for more 

precision.  
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A New Rapid Plot Option 

 
Rapid Plot Form 

Surface Engineering 

Interval Intersection 

The interval intersection process has been enhanced to improve execution time. 

Additionally, a new Volume Tolerance field has been added to the form which 

allows users to input the minimum desired volume tolerance for the output block. 



MineScape 2023 Update 2 Release Notes 
 

 

 
14 

 

NOTE: The unit follows the unit defined in the MineScape's Project Properties. 

 

New Volume Tolerance Field 

Reserves 

Volume Calculations to Support Mesh 

In addition to Triangle, users can now calculate volume using Mesh as the Data 

Source. By default, Mesh is selected. 

This functionality is accessible in the Stratmodel and Open Cut through the 

Engineering Group of the Reserves Tab, and in the Survey, UG Coal, and UG 

Surveys apps within the Reserves Group under the Reserves Tab. 
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Reserve Calculate Volume with Mesh as the Default Data Source 

Scheduling 

Improved the Sequence Dock Usability 

The Sequence Dock has been enhanced with several new functionalities for 

better usability. 

 
Improved Sequence Dock 

• The Eye Icon displays the sequence number and colour when toggled ON, 

otherwise they will be hidden. 
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• The Colour Box provides better visualisation and displays a colour picker 

dialog box when clicked 

• The Checkbox Icon displays the equipment model when clicked 

 

Improved the Equipment Utilisation & Availability Form 

• Added a row fill down functionality in the Equipment Utilisation & 

Availability Form that is accessible by right-clicking a cell under the 

Equipment Utilisation or Equipment Availability Column. This feature 

enables users to quickly populate multiple rows with the same value.  

 
Row Fill Down Functionality in the Equipment Utilisation & Availability Form 

• The Duration column now aligns with the calendar when Period is set to 

monthly, rather than fixed at 30 days.  

• A new Export to CSV button located in the upper-right corner of the form 

allows users to export equipment utilisation & availability data to a .CSV file. 

As part of this update, the Import CSV Form has also been enhanced to 

allow importing the same type of data.  
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A New Import Option 

Other Scheduling Enhancements 

• A new Angle Threshold field is added to both pit face positions forms. 

Higher thresholds generate more lines/edges, potentially increasing noise, 

while lower thresholds may result in missing lines/edges. The default value 

is 12. More Contour Options are also added: Contour Interval, Annotation 

Frequency, Major Contour and Minor Contour. These functionalities are 

taken from the existing Contour Form.  
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New Options in the Pit Face Positions Forms 

• Added a confirmation dialog box that appears before deleting a block or a 

sequence, providing an opportunity for review and preventing accidental 

deletions.  



MineScape 2023 Update 2 Release Notes 
 

 

 
19 

 

 
A Confirmation Dialog Box 

• When generating pit face positions by periods, all layers with duplicate 

dates will be created by adding a suffix incrementally to avoid duplicate 

names. For example, 12022024A, 12022024B, and so on.  

• Auto save feature is now implemented in the Mine Map and Activity Map 

Windows.  

• Added an error message that displays when blocks being picked contain 

an incorrect activity, e.g., waste blocks should have waste removal activity 

instead of coal mining activity.  

• Added an error message that displays when trying to open a schedule 

project that’s located outside the folder of the currently opened MineScape 

project.  

• The triple dot buttons next to the meta-data in the Properties Dock are 

hidden until the Scheduler App is loaded.  

 

Drone Surveying 

Point Cloud Tools 

More Actions in the Running Jobs Form 

The Running Jobs Form has been revamped for more flexibility. It allows users to 

view, stop, and delete running jobs via the new Stop, Delete, and View Log 

Options. Users can also save logs by accessing the View Log Option and clicking 

the Save Log Option.  
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Three new statuses are added to the Status Column: 

• Stopped: The job is stopped 

• Deferred: A series of queued jobs that will run in the order they are 

scheduled to be completed. 

• Unable to Run: Deferred jobs that will not be executed in the future. This 

may occur if a job in the queue fails, preventing subsequent jobs from 

running.

 

Improved Running Jobs Form 

Classify Noise 

The improved Classify Noise Form allows users to remove points that have been 

classified as Noise and automatically store the new point clouds without noise to 

a desired output .LAS File.  
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Classify Noise Form 

Remove Points by Class 

The new Remove Points by Class Option allows automatic removal of previously 

classified points according to the classes chosen by users.  

Find the Remove Points by Class Option within the Clean Group of the Point 

Cloud Tab.  

 
A New Remove Points by Class Option 

The example below shows points classified as building are removed. 

Before 
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After 

 

Image Validation when Generating Point Clouds with Images  

When users upload images for point cloud generation and those images lack 

camera information, a New Camera Model dialog box will now appear. This 

allows users to input camera details such as model, maker, sensor width, and 

focal length.  
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NOTE: If users are using existing scenarios created before MineScape 2023 

Update 2, the dialog box will not appear immediately. Instead, a new 'Update 

Camera Model' button will be displayed. Clicking this button will prompt the 

dialog box to appear. 

 
New Camera Validation Dialog Box 

New Warning Message for Missing Geotag Information 

If geotag information is absent during point cloud generation from images, a 

new warning message now appears at the bottom of the Generate Point Cloud 

from Images Form. While users can proceed with the process, it may cause the 

resulting point clouds to contain incorrect coordinates. Consequently, this will 

prevent the generation of orthoimages. 
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A New Warning Message for Missing Geotag Information 

Tools 

Report Designer 

Users can now print their personalised reports directly from the Report Designer 

Tool. This Option is accessible within the Export Group of the Report Designer 

Tab, available when in Preview Mode. 

 
Print Option in Report Designer Ribbon 
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Bug Fixes 

This section lists all bug fixes and corrections delivered through MineScape 2023 

Update 2. 

System Service 

• Fixed an issue where MineScape System Service was unable to be installed 

in a freshly-installed Windows 10 machine.  

Start Page 

• Fixed an issue where the Start Page did not display the Christmas greeting 

form.  

Core 

• Fixed an issue where Format Painter did not copy the fill background 

colour.  

•  Fixed an issue where users could not insert a minus sign in the Height Cue within 

Visual Overrides.  

• Fixed an issue where the Explorable Service retained the selected Mesh 

after node deletion, causing multiple loads and unloaded nodes.  

• Fixed an issue where the Explorable Service retained the selected Design 

Layer after node deletion, causing multiple unloaded nodes.  

• Fixed an issue where removing a design file with multiple layers from the 

Display Dock and then selecting one of the layers prevented the loading of 

multiple selected layers.  

• Fixed an issue where the prompt in Height Cue on Visual Overrides 

continued to ask for the second colour from the previously chosen palette 

after selecting another colour palette.  
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• Fixed an issue where symbols could be entered in the Start Height and End 

Height fields.  

• Fixed an issue where the Current Unit for the Category continued to follow 

the setting from the previous project on the Edit Project Units form.  

• Fixed an issue where drill holes were not visible on the Top and Fit view 

modes on the CAD window.  

• Fixed an issue where the selected Marker type on Visual Overrides was 

not applied to drill holes.  

• Fixed an issue where the the primary and secondary colours in the Cycle 

Background Colours of the Graphic Settings Form always switched to 

black.  

• Fixed an issue where users couldn’t change a primary colour in the 

Graphics Settings Form.  

• Fixed an issue where decimal texts were displayed as zero in the Properties 

Dock.  

• Fixed an issue where the Clip Direction Form didn’t appear after clicking 

the Apply Button in the Planes Form.  

• Fixed an issue where the temporary line didn’t honour the CAD colours  

• Fixed an issue where pressing the Reset Button in the Graphics Settings 

Form didn’t reset the direction for the Cycle Background Colours settings  

• Fixed an issue where overwriting existing data in the Contour Form 

resulted in incorrect results 

• Fixed a crash that occurred when closing MineScape with a specific layout  

• Fixed an error that occurred when processing a grid file with expression  

• Fixed an issue where MineScape stopped working after right-clicking on 

nominated triangle sets  

• Fixed an issue where the viewport background displayed incorrect 

gradient colour after re-opening MineScape using session 
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• Fixed an issue where no CAD Window was loaded automatically after 

opening a session file 

• Fixed an issue where the Input and Output box labels and order were 

incorrect on Grids >> Process >> Merge.  

 

Mesh 

• Fixed an issue where polygons couldn’t be selected when creating a 

surface mesh  

• Fixed a display issue where the form title was mesh_settings instead of 

Mesh Settings 

• Fixed an issue where MineScape didn’t read the existing surface mesh 

definition 

• Fixed an issue where the mesh wasn’t immediately updated after 

changing the Trim Surface value  

• Fixed an error that occurred when creating a mesh between crest and toe  

• Fixed an issue where creating solid using the Between Surfaces Option 

resulted in surface mesh being generated  

Geology 

Stratmodel 

• Fixed an issue where the Polygon of Influence wasn't merging properly due 

to a malfunction in the Horizontal Calculation on the Create Resource 

Classification form.  

• Fixed an issue involving the omission of the polygon in Stratmodel >> Drill 

Holes >> Graphics >> Polygon of Influence.  
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• Fixed an issue where overflowing text expanded the fields in the Set 

Current Model form under Stratmodel >> Set Model to the right. 

• Fixed a performance issue when running the reserve categorisation using 

Mesh surface.  

• Fixed an issue where drill holes were incorrectly connected to other holes 

after the import process 

• Fixed an issue where the output table file produced from the Resolve 

Interval/Split Composite Form displayed many zero values 

• Fixed an issue where column mapping didn’t work when trying to import 

drill holes data and the Has Header Option was selected  

• Fixed an issue where merging polygons of influence failed when using 

horizontal calculation  

GDB 

• Fixed an issue where all values were rejected after importing .LAS files.  

• Fixed an issue where the Import CSV Form didn’t recognise Polish 

characters  

• Fixed an issue where the Setup Dictionary Validation wasn’t applied, 

resulting in the .LAS file still being imported  

• Fixed an issue where the drill hole direction was incorrect when the 

declination value was set to zero  

• Fixed an issue where drill hole values couldn’t be updated through the 

View Single Hole Form  

• Fixed an issue where inputting characters in the Drill Hole Type field could 

exceed 4-character limit when importing drill hole data  

• Fixed an error that occurred when trying to load data into the Proximate 

table  
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Plot Designer 

• Fixed an issue where the ScaleBar on Plot Designer was appearing 

shrunken in Print Preview mode.  

• Fixed an issue where a plot file with the default name could not be opened.  

• Fixed an issue where the background colour in the plot paper wasset 

according to the colour settings in the Graphics Settings Form.  

• Fixed a crash that occurred after changing the scalebar type in the 

Properties Editor  

• Fixed an issue where the scale bar displayed an empty value in the 

Properties Editor  

• Fixed a crash that occurred when adding a new scale bar container to a 

plot design file  

• Fixed an issue where the Page Setup form on Plot Designer would expand 

to the right if the text in the Description field exceeded its width.  

• Fixed an issue where the Error message on the Borrow End Date was 

truncated when exceeding the form width.  

• Fixed an issue where the graphics of the Triangle Prisms were not 

displayed in a plot file.  

Surface Engineering 

Open Cut 

• Fixed an issue where using invalid characters for rapid slicer operation still 

continued the process even though it kept throwing an error message  

• Fixed an error that occurred when trying to generate a report in an .XLSX 

format with a long path name  

• Fixed an issue where the schema name in the Interval Intersection Form 

wasn’t automatically loaded 
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Mining Blocks 

• Fixed an issue where the selected scenario appeared to be invalid when 

creating mining blocks for single bench  

• Fixed an issue where the mining blocks disappeared from the CAD 

Window in the middle of cutting process  

• Fixed an issue where closing the spreadsheet editor after generating 

Mining Block reports would lead to the CAD App instead of the Mining 

Blocks App  

Dragline 

• Fixed a precision issue when snapping to tagged points  

Scheduling 

• Fixed an issue where the Generate by Periods form couldn’t be opened 

due to an SQL query error.  

• Fixed a crash that occurred when closing the Settings Form within the 

Animation Tab if no mesh was loaded in the CAD Window.  

• Fixed an issue where toe lines were not created when generating pit face 

positions because there was only one bench left.  

• Fixed an error that occurred when creating a sequence using the Line or 

Polygon method.  

• Fixed an issue where the sequence animation could not play until it 

finished.  

• Fixed an issue where the sequence animation did not follow the correct 

order.  

• Fixed an issue where a truck's destination was incorrect due to Scheduling 

allowing a truck to carry multiple activities.  
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• Fixed an issue where the Save confirmation box for Activity Map did not 

appear.  

• Fixed an issue where an error message appeared after users cancelled 

opening projects.  

• Fixed a display issue in the Schedule Toolbar to prevent truncated controls.  

• Fixed an issue where equipment utilisation & availability was not calculated 

in the sequence, which resulted in exceeding equipment work hours for 

the day.  

• Fixed an exception that occurred when picking a block while a schedule 

constraint was not defined.  

• Fixed a crash that occurred when picking a block.  

• Fixed an issue where the Activity toolbar showed an empty list even 

though activities were defined in the Activity Map 

• Fixed an issue where generating pit face positions by progress resulted in 

incorrect toe and crest lines  

• Fixed an error that occurred when opening a schedule project caused by 

overlapping loading action from session events 

• Fixed an issue where MineScape failed to save connection materials in the 

Mine Map 

• Fixed a crash that occurred after changing the animation settings 

• Fixed an issue where the fields in the New Schedule Project form were 

being truncated, causing incomplete information display 

Drone Surveying 

Point Cloud 

• Fixed an issue with saving zone values in Point Cloud >> Coordinate 

System Setting 
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• Fixed an issue where the Filter and Create Mesh Ribbons were still 

available when no point clouds .LAS files were displayed in the CAD 

Window 

• Fixed an issue where orthoimages couldn’t be generated 

• Fixed an issue where the Next Button on the Options Tab was not disabled 

in the generate Point Cloud from Images Form even though there was no 

more steps left  

• Fixed an issue in the Running Jobs Form where the subsequent job would 

continue even though the previous job failed  

• fixed an issue where the undo function didn’t work after performing the 

Delete Points operation  

• fixed an error that occurred when trying to set values in the Coordinate 

System Form  

• fixed an issue where the error message didn’t appear when the job to 

generate point clouds from images failed  

• fixed an issue in the Running Jobs Form where the failed jobs were listed 

in between jobs that were still in progress  

• Fixed an issue where the Status Column for other jobs were empty after 

the Generate Point Cloud Job was stopped  

• Fixed an issue where removing removing height cue colours in the Visual 

Override Dock also resulting in point cloud colour being removed  

• Fixed an error that occurred when generating partial point cloud job 

 

Survey Data Manager 

• Fixed a display issue in the Revisions Form where no scrollbar was present 
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Survey Server 

• Fixed an error that occurred when starting the service because of 

insufficient delay time 

Tools 

• Fixed a crash that occurred when saving a spreadsheet as a .PDF file  

• Fixed an issue where the previous Survey Server version wasn’t successfully 

uninstalled  

• Fixed an error that occurred when trying to record MineScape workspace 

using the Screen Recorder Tool 

Removed 

• Removed the sequence colour setting in the Settings Option of the 

Schedule Setup Tab. Sequence colour can now be configured directly in 

the Sequence Dock next to the sequence name. 

• Removed the Scale, Rotate, Interactive Curve, Reverse actions from the 

right-click option of RapidCAD 


